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Copyright and Trademark Notice
Copyright
All material contained in this document is protected by copyright law.
©2008 Bremco, Inc. (dba Accountable Software) All Rights Reserved

Trademarks
Forms Printer is a trademark of Bremco, Inc. (dba Accountable Software). Other company or product names
mentioned may be trademarks or registered trademarks of their respective holders.
Microsoft Dynamics is a trademark of Microsoft Corporation in the United States and/or other countries.
Microsoft product screenshots reprinted with permission from Microsoft Corporation.

Page |5

Installation Checklist
1.

Download the latest version of Forms Printer

2.

Obtain version 10.50 Registration Keys

3.

Run the installation executable on the first workstation

4.

Delete the FPD1230.dic and ASI1655.dic client files

5.

Launch Dynamics GP using an Administrative user

6.

Include new code

7.

Install and Initialize tables in first Company

8.

Enter Registration Keys

9.

Install and Initialize tables in additional Companies

10. Add Dynamics GP Roles and Tasks
11. Enter Report Engine Setup Information
12. Enter Forms Printer Setup Information
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Installation and Administrative Setup
The initial installation of Forms Printer is performed in several steps. First is the installation of the initial
Forms Printer client application. Next, the Forms Printer client code is included in the Microsoft
Dynamics™ GP client application set. Following the code inclusion is the installation of SQL Server
objects and data. Next, the Forms Printer Registration keys are entered to enable the application. Once
Forms Printer is registered, the next three setup steps can be completed in whatever order you wish.
These steps are to install additional workstations with the client application, to enter Roles and Tasks in
the new Dynamics GP security models and to add Report Engine Setup information.

Installing the First Forms Printer Client Application
The installation of the initial Forms Printer client application is different than subsequent installs
because 3 additional steps must be followed. Those steps are to: Include Forms Printer in the Dynamics
GP Installation, Enter Forms Printer Registration Keys, and Install SQL Server Objects in Additional
Companies.

Run the Forms Printer Installation File
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP
client workstation:
1. Download the Forms Printer Installation File
a. Download the latest version of Forms Printer. Checking our web site for the most
current version of the product before installation ensures that any updates or fixes are
installed and is highly recommended.
b. The file downloaded from the Accountable Software Resource Center will contain an
installation file named Forms Printer XXXX.msi (where the XXXX will be the installing
version).
2. Double Click on the setup.msi installer file to begin the installation.
3. Follow the installation wizard to complete the installation of Forms Printer.
a. The installation program begins with a “Welcome” window. Take a moment to verify
that the proper version for you Dynamics GP application is being installed.
When ready, click Next>.
b. Review the license agreement, and if you agree, confirm your acceptance to the terms
described within by clicking I Agree. Note: You cannot install Forms Printer if you do not
accept the terms.
When ready, click Next>.
c. Review the Additional License Agreement required for using the Business Objects
Runtime. If you agree, confirm your acceptance to the Business Objects terms described
within by clicking I Agree. Note: You cannot install Forms Printer if you do not accept the
terms.
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When ready, click Next>.
d. Select the folder in which the Microsoft Dynamics™ GP application is installed. This
folder is typically located on your local hard drive. The install program will attempt to
default the installation to The Microsoft Dynamics™ GP Application folder. If the
detected folder is not the location where Microsoft Dynamics™ GP is installed on your
machine you will need to select the correct folder in which to install Forms Printer.
When ready, click Next>.
e. The Confirmation window provides a final opportunity to ensure the proper version
installed.
When ready, click Next>.
The setup program will then begin to copy all files to the appropriate directories.
f.

When the installation has completed the final Information window displays important
information on documentation and other file locations.
When ready, click Next>.

g. The installation complete window is displayed.
When ready, click Close.

Remove the Old Dictionary Files
Prior to launching Dynamics GP after the installation, use Windows Explorer to navigate to your
Dynamics GP client directory. From that folder, find the files FPD1230.dic and ASI1655.dic. These files
must be renamed, moved or deleted. It is recommended that you rename them to FPD1230_old.dic and
ASI1655_old.dic so that you have the files to revert to in the case of an installation issue.

Include Forms Printer in the Dynamics GP Installation
1. Launch Microsoft Dynamics™ GP
2. Log in as ‘sa’ or a database administrator.
3.

A dialog window prompting to include the new code will be displayed, as shown in the following
illustration:
Click Yes, and wait until the process has completed.
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A progress bar will display, while the “unchunking” process is executing. At this point, our
DYNAMICS.SET file will be modified to include the information required to run Forms Printer, and
two dictionaries named “FPD1230.DIC” and ”ASI1655.DIC” will be created in your Microsoft
Dynamics™ GP application folder.

Install SQL Server Objects
After the new code is loaded, you must install Forms Printer to the SQL Server Database and will be
prompted to do so. When prompted, using the steps below and you must repeat this database
installation for each Dynamics GP Company by logging into each company and repeating the steps:
1. When presented with the dialog window prompting to install and initialize Custom Report
Integration tables click Yes to initialize the new tables.
2. When presented with the dialog window prompting to install and initialize Forms Printer tables
click Yes to initialize the new tables.
3. If running the Project Accounting module, you will be prompted with the dialog window asking
to initialize Project Accounting tables click Yes to initialize the new tables.

Enter Forms Printer Registration Keys
Once the Database installation is completed you will be presented with the message to enter
registration keys. To register Forms Printer follow these steps:
1. When prompted to register, click Yes to open the Forms Printer Registration window.
If no registration prompt is presented, open the Accountable Software Registration window by
clicking the Help icon, then selecting About Microsoft Dynamics™ GP. The About Microsoft
Dynamics™ GP window will open and a Forms Printer Registration window will open as a
companion window.
2. Click the Register button to open the Forms Printer Registration window.
Enter the registration keys exactly as you received them from Accountable Software for your
Microsoft Dynamics™ GP installation. Registration keys are provided by Accountable Software
directly. For more information or to obtain your registration keys, please call (484) 875-0600 or
email sales@accountable.com.
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If you mistyped the keys, you will receive a warning message. Try again. If you still receive a
warning, contact Accountable Software for assistance at techsupport@accountable.com.
3. Click Register.
4. Verify the Registration Keys.
If the module(s) you are registering appear with a checkbox in the Registered column, the
registration was successful.
Click the Close.

Install SQL Server Objects in Additional Companies
To complete the SQL Server installation process, it is required that the following steps are completed for
each Company:
1. Log in as ‘sa’ or a database administrator.
2. When presented with the dialog window prompting to install and initialize Custom Report
Integration tables click Yes to initialize the new tables.
3. When presented with the dialog window prompting to install and initialize Forms Printer tables
click Yes to initialize the new tables.
4. If running the Project Accounting module, you will be prompted with the dialog window asking
to initialize Project Accounting tables click Yes to initialize the new tables.

Installing Forms Printer on Additional Workstations
In order to use Forms Printer on additional workstations, you must follow the client installation steps on
those workstations. Note that once the previous steps have been completed the SQL Server installation
and registration key entry is completed and does not need to be repeated. For additional workstation
installs, follow these steps:

Run the Forms Printer Installation File
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP
client workstation:
1. Download the Forms Printer Installation File
a. Download the latest version of Forms Printer. Checking our web site for the most
current version of the product before installation ensures that any updates or fixes are
installed and is highly recommended.
b. The file downloaded from the Accountable Software Resource Center will contain an
installation file named Forms Printer XXXX.msi (where the XXXX will be the installing
version).
2. Double Click on the setup.msi installer file to begin the installation.
3. Follow the installation wizard to complete the installation of Forms Printer.
a. The installation program begins with a “Welcome” window. Take a moment to verify
that the proper version for you Dynamics GP application is being installed.
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When ready, click Next>.
b. Review the license agreement, and if you agree, confirm your acceptance to the terms
described within by clicking I Agree. Note: You cannot install Forms Printer if you do not
accept the terms.
When ready, click Next>.
c. Review the Additional License Agreement required for using the Business Objects
Runtime. If you agree, confirm your acceptance to the Business Objects terms described
within by clicking I Agree. Note: You cannot install Forms Printer if you do not accept the
terms.
When ready, click Next>.
d. Select the folder in which the Microsoft Dynamics™ GP application is installed. This
folder is typically located on your local hard. The install program will attempt to default
the installation to The Microsoft Dynamics™ GP Application folder. If the detected folder
is not the location where Microsoft Dynamics™ GP is installed on your machine you will
need to select the correct folder in which to install Forms Printer.
When ready, click Next>.
e. The Confirmation window provides a final opportunity to ensure the proper version
installed.
When ready, click Next>.
The setup program will then begin to copy all files to the appropriate directories.
f.

When the installation has completed the final Information window displays important
information on documentation and other file locations.
When ready, click Next>.

g. The installation complete window is displayed.
When ready, click Close.

Remove the Old Dictionary Files
Prior to launching Dynamics GP after the installation, use Windows Explorer to navigate to your
Dynamics GP client directory. From that folder, find the files FPD1230.dic and ASI1655.dic. These files
must be renamed, moved or deleted. It is recommended that you rename them to FPD1230_old.dic and
ASI1655_old.dic so that you have the files to revert to in the case of an installation issue.

Include Forms Printer in the Dynamics GP Installation
1. Launch Microsoft Dynamics™ GP
2. Log in as ‘sa’ or a database administrator.
3.

A dialog window prompting to include the new code will be displayed, as shown in the following
illustration:
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Click Yes, and wait until the process has completed.
A progress bar will display, while the “unchunking” process is executing. At this point, our
DYNAMICS.SET file will be modified to include the information required to run Forms Printer, and two
dictionaries named “FPD1230.DIC” and ”ASI1655.DIC” will be created in your Microsoft Dynamics™ GP
application folder.

Uninstalling Forms Printer
If it becomes necessary to temporarily disable Forms Printer on a Microsoft Dynamics™ GP workstation,
one can use the Microsoft Dynamics™ GP Tools->Customization->Customization Status Window to Disable
the Forms Printer product for one login Session.
In order to more permanently disable Forms Printer on a Workstation, one must edit the Microsoft
Dynamics™ GP “Launch” file (typically named dynamics.set) to remove references to the Forms Printer
Product (ID = 1230), and the Supporting “CRI” component (Product ID = 1655) . Microsoft Dynamics™ GP
provides a facility for editing the launch file from the Tools->Setup->System->Edit Launch file menu. The
Microsoft Dynamics™ GP Help Topic from this window describes how to remove a product from the Launch
File using a text editor.
In order to Completely remove Forms Printer and the Components that it installed, one should remove it
from the Launch file, then remove the runtime components using Windows “Add –Remove Programs”
Control Panel Applet, Then optionally delete the FPD123.DIC Forms Printer Dictionary, and optionally
Drop the ASI123* Tables and stored procedures in the Microsoft Dynamics™ GP Company SQL Databases.

Adding Roles and Tasks
With the new Security model implemented in Microsoft Dynamics™ GP 10, it becomes necessary to
enable logins to use or administer Forms Printer by placing the users in Dynamics GP Roles. These Roles
are made of Dynamics GP Tasks that allow access to various programs and code resources.

Roles
When Forms Printer Is initialized and logged into the first time, by ‘sa’ or ‘DYNSA’, The Following Tasks
and Roles are created:
FORMS PRINTER (CRI) ADMIN
This role allows administration of the “Custom Report Integration” (CRI) settings that Forms Printer uses
to connect the Crystal Reports Reporting Engine to the SQL database.
FORMS PRINTER OPTIONS ADM
This role allows users to access the Forms Printer Setup window where the setup and administration of
various reports printed by Forms Printer are maintained.
FORMS PRINTER USER
This role is for users all users of Dynamics GP that will be using Forms Printer in any capacity to print
reports. While it currently uses the same settings as the FORMS PRINTER OPTIONS ADM role, it can be
modified as needed to restrict access to setup windows.
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All GP users who need to use Forms Printer should have at least the FORMS PRINTER USER Role added
to their user security role list. If all users need access to Forms Printer printing, one can add the Forms
Printer Security Tasks directly to a broadly applicable role which many users already have been placed
in, such as “ORDER PROCESSOR”.
Example: Adding the Forms Printer Administrator/User Tasks to the General “Order Processor” Role add
the Security Task ID’s for the Setup Windows, and Forms Printer Options Windows:

Tasks
The Task ID’s above, can be duplicated, and then modified, if you need to apply finer grained control to
users with regards to what Forms Printer related windows they can open. The Default Security Task ID’s
for Forms Printer are defined as shown below:
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Also: See the specific added window Operations under the ADMIN_FP_CRI_01 Task ID for the System
series.

Also: See the specific added window Operations under the ADMIN_FP_CRI_02 Task ID for the
Purchasing, Sales, and System series.

Enter Report Engine Setup Information
From the Forms Printer Setup Window, the Report Engine Setup menu option includes two listings:
Crystal Reports Setup, and SQL Server Reporting Services Setup. Report Engine refers to the reporting
tool used to print reports from Forms Printer. Select the Reporting Engine you wish to setup.
Note: You may use both the Crystal and SRS Reporting Engines with different reports setup to use
either engine.
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Window Navigation
To open the Report Engine Setup window, you must first Open the Forms Printer Setup window using
the menu navigation: Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer
On the Forms Printer Setup window, select Report Engine Setup then either Crystal Reports Setup, or
SQL Server Reporting Services Setup.
This screenshot shows the Report Engine menu from the Forms Printer Setup window.

Crystal Reports Setup
Press this button to open the Report Integration Setup Window where the Report Authentication for
Crystal Reports can be specified.

Window Buttons
The buttons on the SQL Server Reporting Services Setup Window include:
Buttons
Save

Description
Saves the current entry values and closes the Window.

Window Fields
Fields
Manually enter a SQL login and password

Description
Mark this checkbox to enter a SQL Server user and password.

SQL User Name

Enter a valid SQL login.

SQL Password

Enter the password for the SQL User

Verify Password

Verify the password by entering it again.
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Window Example
The screenshot below shows the entries for Crystal Reports using an example SQL Login
“FormsPrinterUser”.

SQL Server Reporting Services Setup
Prior to using SQL Reporting Services [SRS] with Forms Printer, you must add SRS setup information. The
use of SRS with Forms Printer is dependent on an installed and properly functioning SRS installation.
Note: Installing Forms Printer DOES NOT affect an existing SRS installation in any way, nor does it
install SRS or any files required to run an SRS installation.

Window Buttons
The buttons on the SQL Server Reporting Services Setup Window include:
Buttons
OK
Cancel

Description
Saves the current entry values and closes the Window.
Closes the window without saving any changes to the
current entry values.

Window Fields
Fields
SRS Report Server URL
SRS Report Server Web Services URL
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Description
This editable text field is used to enter the path to the
Report Server Web Application
This editable text field is used to enter the path to the

specific Web Services asmx page in the Reporting
Services Web Applications.

Window Example
The screenshot below shows these entries for a default installation of Reporting Services on an example
Web Server named “mywebserver”.

P a g e | 17

Enter Forms Printer Setup Information
Overview
Once the Administrative steps of installing Forms Printer, entering the required Roles and Tasks, and
entering Report Engine information have been completed, the next step is to begin the set up Forms
Printer.

Forms Printer Setup
To access the setup information, use the Menu item shown in the Window Navigation section, or add
the Forms Printer Setup window to your work button or Shortcut Bar.

Window Buttons
Buttons
Save
New

Delete
Report Engine Setup

Description
Saves any changes made to window values.
This button lists choices for adding new entries. The
available values vary depending upon the entry currently
selected in the tree view.
Deletes the currently selected entry from the tree view.
Displays the Report Engine Setup menu options for setup
of the available reporting tools.

Window Fields
Fields
Description
Report / Company / Master Record This treeview list is used to display and modify the list of
List
reports, Companies, and Master records that are setup to
use Forms Printer.
Record Entry Setup Page
This editable page is used to determine the various
settings for the record selected in the treeview.
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Window Example
This screenshot shows the Forms Printer window as it will appear prior to adding any report records.
NOTE: If you are upgrading Forms Printer, all of the reports you had setup in your earlier version will
be migrated to the new setup and you will see your settings listed here.

Report

Record

Company

Entry

Master Record

Setup

List

Page

Report / Company / Master Record List
The list of reports, Companies and Master Records which will be controlled by Forms Printer are
displayed in the treeview. Upon installation and prior to the first added Report, this list is blank.
Once you’ve added a report for printing with Forms Printer, you can then add one or more Companies
beneath the report entry if different settings per company are desired.
Finally, once a Company has been added, you can add one or more Master Records beneath the
Company allowing a Master record to have specific settings for report or delivery.
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To begin adding reports, follow these steps:
1. Click the New button from the control area.
2. Select Include New Report from the dropdown menu.
3. From the Include New Report window, select a Product.
The Product is the Dynamics GP module or 3rd party containing the report to be added.
4. Select the Series.
The Series is the Dynamics GP series containing the report to be added.
5. Select the Report from the dropdown list.
The Report drop down list is the Dynamics GP reports available.
6. Click Save.
The screenshot below shows the Include a New Report window.

To add a Company, follow these steps:
NOTE: Only Add Companies if you want DIFFERENT settings between companies or Master Records. If
all Companies or Master Records will use the same report and settings, you do not need to add
Company Records.
1.
2.
3.
4.
5.

Select a Report in the Report / Company / Master Record List.
Click the New button from the control area (or right click in the treeview).
Select Include New Company for Selected Report from the dropdown menu.
From the Include a New Company window, select a Company from the dropdown list.
Click Save.

This screenshot of the Include a New Company window shows an example of the Product, Series, and
report fields as well as the selected Company to be added.
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To add a Master Record, follow these steps:
NOTE: Only Add Master Records if you want DIFFERENT settings between Master Records. If all
Master Records will use the same report and settings, you do not need to add Master Record
entries.
1.
2.
3.
4.

Select a Company in the Report / Company / Master Record List.
Click the New button from the control area (or right click in the treeview).
Select Include New Master Record for Selected Report and Company from the menu.
From the Include a New Master ID window, select a Master ID by clicking on the Master ID
Lookup.
5. This will open a lookup window where you can select a Master ID and return it to the Include a
New Master ID window.
6. Click Save.
This screenshot of the Include a New Master ID window shows the selected report and Company to
which the Master ID is being added.
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Record Entry Setup Page
For each of the records added to the Report / Company / Master Record list, the Record Entry Setup
Page is used to determine the individual settings for report engine, report source, printing and Delivery.
NOTE: When adding a new entry to the Report / Company / Master Record list each record will, BY
DEFAULT, be set to “To Printer’ with number of Copies set to 1. Also note that all entries must
have at least one Delivery Setting either “To File”, “To Printer”, or “To Mail”.

Window Fields and Controls
Fields
Report Tool

Report Path

Description
This dropdown list is used to select the Reporting engine
desired for the selected Report / Company and / or
Master Record.
If using Crystal Reports this is filed and lookup are used to
select the rpt file Forms Printer will use.
When using SRS, this field and lookup are used to select
the SRS Report, from the Select Report window of SRS
reports.

To Disk File

Mark this checkbox to have the report exported to a file
each time it is delivered, regardless of whether ‘File’ was
selected as the destination on the Report Destination
window.

File Format

The File Format selection determines the format for the
exported document.

Save Folder

Determines the directory in which Forms Printer will
create the exported file. This is the path to the directory,
and does not include the file name. Forms Printer
automatically names the file to ensure a unique file name
is created.
When printing single documents, the file is named with
the convention: Document Type Document Number
System Date System Time.extension
For Example: Order ORD0001 06-25-01 8 30 27AM.PDF
When printing batches or ranges of documents, the file is
named with the convention: Document Type First
Document Number to Last Document Number System
Date System Time.extension
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For Example: Order ORD0001 to ORD0005 06-25-01 8 30
27AM.PDF
The exception to this convention is Statements. Because
Statements do not have a document number, the naming
convention is:
Document Type Customer Number System Date System
Time.extension
Or
Document Type First Customer Number to Last Customer
Number System Date System Time.extension
Note: If the document being exported has any custom
master record settings, for ANY master record,
then Forms Printer will create individual files per
document, even when printing batches or ranges.
To Printer

Print Using

Selecting the ‘To Printer’ checkbox enables the Delivery
System printer output. By default this option is checked.
Marking this option will send a copy of the report to the
printer whenever the delivery system is used. Left
unmarked, the report will only print to the printer if the
‘Print’ option is selected on the Report Destination
Window.
Print Using determines where the document will be
printed when used within Microsoft Dynamics™ GP. The
valid choices are described below.
Printer Saved On Report
This setting will direct the Crystal report to the
printer saved in the Crystal Report Designer Print
Setup window when the report was designed or
modified. If the report has no defined printer or
the defined printer is not available from the
workstation, the default system printer will be
used.
Default System Printer
This setting instructs Forms Printer to print the
selected Crystal report to the default printer
defined on the user’s workstation.
Ask Each Time Report Prints
This setting will allow you to select the printer at
the time the report is printed. Using this setting
will direct the Crystal report to the selection
made during the printing process.
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Copies To Print

Number of copies determines the quantity output to the
printer when the Crystal report is printed. This quantity
will override any quantity selected from the print dialog
within the report print setup, or the system default print
setup. If using ‘Ask Each Time’, then the number of copies
entered in the properties window will be used.
Note: If the ‘To Printer’ checkbox is selected for a
Report or Company, a copy of the document will
be printed every time the Delivery System is
used. To have the document print to the printer
only when specified, mark the ‘To Printer’
checkbox, set the desired ‘Print Using’ and
‘Number of Copies’ options, then unmark the ‘To
Printer’ checkbox. This will allow Forms Printer
to use your printer settings, but only print to the
printer when ‘Printer or Delivery System’ is
selected from the Report Destination window,
and Printer is selected from the Delivery System
Dialog window. Note that this functionality DOES
NOT apply to Master Records.
Number of copies can also be set using the optional Print
Dialog window. When printing, Forms Printer reads the
Microsoft Dynamics™ GP ‘NoPrintDialogs’ setting in the
Dex.ini file. If NoPrintDialogs=FALSE, then the user will be
presented with the Crystal Print Dialog window. The
Dialog window allows Number Of Copies and Collate
options to be entered, as well as page ranges.

To Mail

Use Outlook

Selecting the ‘To Mail’ checkbox, allows delivery of the
selected document by E Mail.
Forms Printer will automatically detect whether
Microsoft Outlook is installed, and enable or disable the
Microsoft Outlook Radio button and some of the E Mail
options accordingly.
Note: If using SRS as the Reporting Engine only Use
Outlook is enabled.

Use Crystal MAPI
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If Outlook is not detected and the Reporting engine is
Crystal Reports, then Forms Printer will use the Crystal
Reports MAPI mailing functionality, and automatically
mark the Crystal MAPI Radio button, disabling the option
to use Microsoft Outlook. Even if Outlook is installed, you
may still choose to use Crystal MAPI Mail by selecting the
Crystal MAPI Radio button.

Because of the limits of the Crystal API, certain
functionality is unavailable when not using Outlook.
The functional limits when using Crystal MAPI
functionality are:
1. You cannot specify an ‘E Mail From’ profile.
The default profile will be used as the
‘From’ address.
2. You cannot name the attachment.
The attachment name will be the same
as the Crystal Report used to create it.
3. You cannot specify the Send Option.
The E Mail will be sent automatically to
the recipient.
Mail From

The ‘E Mail From’ dropdown list will be enabled if
Microsoft Outlook is installed. This dropdown list is
populated by default from the Outlook Global Address
List. Here you have the option to use the default Outlook
User, or specify a specific profile to use as the ‘Send On
Behalf Of’ mail ‘From’. If using a profile other than
default user, the default user must have ‘Delegate’
permissions in Outlook. For more information about this
topic, please see the Outlook help documentation
regarding Delegates.
Note: In order to use the ‘To Mail’ feature of the Forms
Printer Delivery System, the client workstation
must have a Messaging Application Programming
Interface (MAPI) compliant E Mail application
loaded. The full version of Microsoft Outlook is
currently the only supported MAPI client
According to the Crystal /Business Objects/SAP
web site.
To have access to all of Forms Printer’s E Mailing
functionality, it is recommended to use Microsoft
Outlook 2000 or Greater.

Mail To

The ‘E Mail To’ dropdown list allows you to select the
Master Record Address from which Forms Printer will
retrieve the E Mail To Address. This E Mail address is
stored per Master Record, per Address, in the Internet
Information window. The Master record is either the
Customer or Vendor for which the document was
created, depending on the document type being printed.

Send Option

The Send Option dropdown list allows you to select the
destination for the created E Mail.
The selections for Send Options are described below.
 Send Directly to E Mail Recipient: Automatically
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Hours To Delay

sends the E Mail.
Save To Outlook Drafts folder: Creates the E Mail
in the Drafts folder. E Mail must be sent
manually.
Save to Outlook Outbox: Creates the E Mail and
saves it to the Outbox. E Mail must be sent
manually.
Save to Outlook Outbox Delayed: Creates the E
Mail and saves it to the Outbox. E Mail will be
sent automatically at the specified time selected
by the Hours to Delay option.
Display created E mail: Creates the E Mail
displays the E mail rather than sending or saving
it. Once any required modifications are made,
the E mail can be modified and then saved or
sent manually.

The Hours to delay option is enabled when the Send
Option dropdown list is set to ‘Save to Outlook Outbox
Delayed’. Setting this number adds the specified number
of hours to the current system time, and uses that to set
the E Mail’s delayed send property. For example, if the E
Mail was created at 10:15 AM, and the Send option was
set to Save To Outlook Outbox delayed, with an Hours To
Delay setting of 12, the E Mail would be created in the
Outbox, and would stay there until 10:15 PM, and then it
would be E Mailed to the selected Recipients.

Additional Mail To Addresses

The Additional Addresses link opens the Additional
Addresses Setup window. This window allows you to
define addresses to mail to, other than the primary
address selected in the ‘E Mail To’ dropdown list.

Attachment Format

The Attachment Format dropdown list allows you to
specify the format for the E Mail attachment.

Attachment Name

The Attachment Name allows you to enter the text, as it
will appear in the E Mail for the attachment name. To
create a calculated Attachment Name, open the Subject
and Attachment Name Editor window using the
expansion button. When creating an attachment name,
the following characters should be avoided, as they are
invalid in the name of a file:
\/?*:“<>|
For help with using the Subject and Attachment Name
Editor, see the Message Editor section below.

Body Text

This field displays the Message ID to be used when E
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Mailing the selected document type.
For more information, see the Message Editor section of
this document.
Message

This field displays the Message Description.

Subject Text

E Mail Subject sets the text, as it will appear in the E Mail
Subject line. To create a calculated subject, open the
Subject and Attachment Name Editor window using the
expansion button.
For help with using the Subject and Attachment Name
Editor, see the Message Editor section below.

Window Example
Below is a screenshot example of a populated Forms Printer Setup window with entries in the Report /
Company / Master Record list and Record Entry Setup Page.

P a g e | 27

Additional E Mail Addresses Setup
The Additional Addresses button opens the Additional Addresses Setup window. This button also
provides a visual indicator as to whether or not additional addresses have been entered. If additional
addresses exist for this document type, the button will be displayed in yellow. When no additional
addresses exist, the button will be white. This window allows you to define addresses to mail to, other
than the primary address selected in the ‘E Mail To’ dropdown list. The screenshot below shows this
window.

Mail Address Type
Determines whether the selected address will be added to the Mail To, Cc, or Bcc list of the E Mail.
Required
Mark this checkbox to have the E Mail halted when the selected address is blank. If using Crystal MAPI
for E Mailing, the E Mail will not be created if the Primary or any Required E Mail Address is blank. If
using Outlook, the E Mail will be created, however the ‘Send Option’ will be ignored, and the E Mail will
be saved as a Draft. In either case, the error will be reported on the Delivery System Error Log, which
prints after an E Mailing error is encountered.
Use E Mail Address Of
The ‘E Mail Address Of’ dropdown list allows you to select the Master Record Address from which Forms
Printer will retrieve the additional E Mail Address. This E Mail address is stored per Master Record, per
Address, in the Internet Information window. The Master record is either the Customer or Vendor for
which the document was created, depending on the document type being printed.
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E Mail CC List
The E Mail CC List allows you to manually enter additional addresses to be Carbon Copied.
E Mail BCC List
The E Mail CC List allows you to manually enter additional addresses to be Carbon Copied.
**Note: E Mail Addresses in the CC and BCC lists must be separated with a Semi-Colon. If you enter a
combination of manual addresses and dynamically selected addresses, Forms Printer will use both to
create a complete Mail To, Cc and Bcc list.

Message Editor
The Message Editor Window is used to create the E Mail message or body for the document type to
which it is assigned. This message can be manually entered text, or a combination of manually entered
text and parameter fields added from specific report tables, system tables, and global fields. When the
message is created and assigned to a particular document, Forms Printer will fill in any parameters using
data associated with the document being E Mailed.
The screenshot below shows an example of a parameterized message for an unposted Sales Order
Processing document.

Note: Parameters appear in the Message Editor Text field surrounded by {}. These brackets and all of
the text that appears between them are required in order for Forms Printer to pull the correct
information. The parameters shown in the message will be replaced with the actual value of
the fields when the E Mail is created. These parameters should not be altered in any way.
Select Form Fields
The Select Form Fields List displays the form tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the message text.
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Select System Fields
The Select System Fields List displays system tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the message text.
Select Global Fields
The Select Global Fields List displays global fields available to be used as parameters for the selected
document type. Double clicking on a field adds that field to the message text.
Browse Data
The Browse Data button displays a list of the first 5 unique values in the selected Form Table column.
This is provided as an easy way to determine the contents of a given field.
Note: Because Message parameters are based on document specific tables, the messages created are
available to be used only by the document group for which they were created. A message
created for a Statement can be used as the message when E Mailing statements. A message
created for unposted Sales Transactions, however, can be used for all unposted Quotes,
Orders, Invoice, Returns, and Backorders. A Message created for Historical Sales Documents
may be used only for posted Quotes, Orders, Invoice, Returns, and Backorders. Messages for
Purchase Orders may be used only for Purchase Order formats.

Subject and Attachment Name Editor
The Subject and Attachment Name Editor Window is used to create the E Mail subject and attachment.
This text can be manually entered text, or a combination of manually entered text and parameter fields
added from specific report tables, system tables, and global fields. When the field is created and
assigned to a particular document, Forms Printer will fill in any parameters using data associated with
the document being E Mailed.
The screenshot below shows an example of a parameterized subject or attachment.
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Window Navigation
To open the Forms Printer Setup window, use the following menu path in Dynamics GP:
Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer
The screenshot below shows the menu path.
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Printing Using the Delivery System
Once the Forms Printer Delivery System has been setup, you can print using the normal processes for
each document type. When printing documents with Delivery System Options, you will be presented
with the Report Destination window, with the destination choices of ‘Screen’, ‘Printer or Delivery
System’, and ‘File’.
Choosing Screen outputs the document to either the Crystal Reports or SRS Preview window.
Choosing Printer or Delivery System displays the Delivery System Dialog window. The Delivery System
Dialog window allows you to select from ‘Printer’ or ‘Delivery System’.
Choosing Printer disregards the ‘To File’ and ‘To Mail’, as well as all of the Delivery System
Master Record Setup options, and prints the report directly to the printer defined in the Delivery
System Document Setup window.
Choosing Delivery System allows Forms Printer to deliver each document to the destination
defined in either the Delivery System Document Setup window.
Choosing File disregards the Delivery System Document Setup options, and exports the Report to the file
and format selected in the Report Destination window. When choosing File, the Export Types dropdown
list will display all of the available Report export types.
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Crystal Reports Setup
The Crystal Reports provided with Forms Printer are samples, intended to be used as templates and are
meant to be generic examples, rather than the solution to every printing situation. These reports will
need to be modified in order to handle specific needs. Before modifying the sample reports, it is
recommended that you have an understanding of Crystal reports. If you are unfamiliar with Crystal
reports, the quick setup is the easiest way to get up and running with the sample reports. If your report
modification includes adding tables to the sample reports, follow the instructions in the Modifying
Sample Reports section pertaining to your database type.

Using Template Reports
The template reports installed with Forms Printer are “generic”, that is: they are designed to work
immediately after installation without the need for modification. Of course, you will at least want to
make cosmetic changes to the logo and company name, etc. These changes can be made very simply
without complex modification to the report.
However, if you are adding tables to the report, or making other more significant changes you must
follow the report modification instructions in the Modifying Sample Reports section.

Installed Template Reports
The Forms Printer Crystal Reports templates are installed into the following folder:
[Dynamics GP Application Folder]\Forms Printer\Crystal Report Templates
Within that subfolder are several subfolders for the supported Dynamics GP series.

Modifying Sample Reports
Step I
Make note of the settings for the DSN used by Microsoft Dynamics™ GP. (Start->Control Panel>Administrative Tools->Data Sources (ODBC)
Step II
Use similar settings to create a temporary named second DSN, using a unique name for the Data Source
Name. For example, use ASIFPTemp. This temporary DSN may be set to use a Microsoft Dynamics™ GP
company database (EX: TWO) as the default, but it is not required.
Step III
a.
b.
c.
d.
e.
f.

Open the sample report using the Crystal Report Designer.
From the toolbar, click Database.
From the dropdown menu, select ‘Set Datasource Location…’
From the ‘Replace with’ list at the bottom of the window, expand ‘Create New Connection’.
Expand ‘ODBC (RDO)’.
From the ODBC (RDO) window, Select the ASIFPTemp DSN from the Data Source Name list,
and then click ‘Next’.
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From ‘Connection Information’, enter a valid User ID and Password.
From the Database dropdown list, select your Company Database.
Click ‘Finish’.
Back on the Set Datasource Location window, expand ‘report’ in the ‘Current Data Source’
list.
k. Highlight the DSN listed.
l. From the ‘Replace with’ list, highlight the ASIFPTemp DSN listed below ‘ODBC (RDO).
m. When both DSNs have been highlighted, click ‘Update’.
n. Click ‘Close’ when finished.
g.
h.
i.
j.

Step IV
Follow the Crystal Reports Application documentation for adding tables in the Crystal Report Designer
using the ASIFPTemp DSN.
Step V
Save the Crystal Report in the directory used in the Forms Printer setup.
NOTE: Repeat Steps II through V for each Sample Report you need to modify.
Step VI
Once each of the reports you intend to modify have been corrected, delete the ASIFPTemp DSN
created in Step I. This allows the generic report to be printed from multiple company databases
using the DSN used to log into Microsoft Dynamics™ GP.

P a g e | 34

SQL Reporting Services Setup
Modifying Forms Printer SSRS Reports
The SQL Server Reporting Services (SSRS) reports that ship with Forms Printer are samples intended to
be used as templates for designing reporting solutions. They will need to be modified before use with
Forms Printer in a production environment.
The reports may be customized and deployed using the SQL Server Business Intelligence Development
Studio application or the Visual Studio application.
Use the following steps to customize a Forms Printer SSRS report, and deploy it to your Report Server,
for use by Forms Printer in Dynamics GP.

Installed Template Reports
The Forms Printer SQL Reporting Services templates are installed into the following folder:
[Dynamics GP Application Folder]\Forms Printer\SRS Report Templates
Within that subfolder are several subfolders for the supported Dynamics GP series.

Steps for Customizing SRS Report Templates
1. Create New Report Server Project. Modification of an SSRS report first requires the creation of a
new Report Server project in your application.
a. Launch either Business Intelligence Development Studio or Visual Studio.
b. Create a new Report Server project by using the Report Server template. The Report
Server template can be found under Business Intelligence Projects in the New Project
window.
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2. Create New Shared Data Source
All Forms Printer SSRS reports are configured to use a data source called GPCompany for data
retrieval. You will need to create this data source in your project. The new data source should
point to a Dynamics GP company database on your SQL Server. To create the data source, right
click on the Shared Data Sources folder in the Solution Explorer window and select the context
menu item to add a new data source. Name the data source GPCompany and set the connection
string to point to a Dynamics GP company database in your SQL Server.
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3. Add Forms Printer SSRS Report To Project
Next, you will need to add the SSRS report that you wish to modify into your project. In the
Solution Explorer window, right click on the Reports folder and select Add, then Existing Item.
Browse the file system to find the Dynamics GP install folder. The Forms Printer SSRS reports are
located in Dynamics GP Series sub folders of the folder SRS Report Templates, a sub folder of
the Dynamics GP client application folder.
Add the report(s) that you wish to modify. The report layout, and SQL query can then be
modified as desired.

All parameters that are passed to each report by Forms Printer are already defined in the report.
Note that the order and data type of the report parameters are important for proper execution
of the report by Forms Printer.
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4. Deploy Modified Report To Report Server
Once you have completed customizing the report, it can be deployed to your Report Server.
Before deploying the report, configure the deployment properties of the project in order to
specify the location of the Report Server and the target folders on the Report Server for your
report and data source. The deployment properties can be set by opening the project property
page from the project menu or from the project folder context menu in the Solution Explorer
window.

Once the deployment properties have been set, the report can be deployed to the Report Server
by selecting Deploy from the Build menu or from the context menu of the report in the Solution
Explorer window.
After the deployment has completed successfully, the report can be selected for use in the
Forms Printer Setup window in Dynamics GP.

Deploying Unmodified Forms Printer SSRS Reports to a Report Server
There may be circumstances when you wish to deploy an unmodified Forms Printer SSRS report to your
Reporting Services Report Server, for instance, when preparing a product demonstration. In such cases,
the Reporting Services Report Manager web application can be used to perform the task. The Report
Manager application allows report files to be uploaded to the Report Server database, which is
equivalent to publishing the reports. Follow these steps to deploy a Forms Printer SSRS report to the
Reporting Services Report Server, for later use by Forms Printer in Dynamics GP.

1. Upload Report File To Report Server
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Launch your web browser and navigate to the Reporting Services Report Manager web
application. By default, the URL is http://<servername>/Reports. Click the Upload File link on
the Contents tab of the Home page, or on any folder page. This will open the Upload File web
page. Browse to the report file on your file system that you wish to upload and select it. The
Forms Printer SSRS reports are located in the Stub SRS Reports folder beneath the Dynamics GP
install folder.
Press OK to upload the report file into the Report Server database.

2. Configure Report Data Source
Once a report has been published on the Report Server using the Report Manager, you will need
to configure its data source. All Forms Printer SSRS reports are configured to use a data source
called GPCompany for data retrieval. If this data source does not exist on your Report Server,
then you can associate the report with any existing data source that points to a GP company
database. To do this, click on the link for the report in Report Manager to open the report. Next
click on the Properties tab at the top of the page, and then click on the Data Source tab at the
side of the page. In the Data Sources page you can browse and select an existing GP company
data source for your report.
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After you have applied the change to the data source of your report, the report is ready for use by
Forms Printer. The report can be selected for use in the Forms Printer Setup window in Dynamics GP.

Multi Company SQL Server Reporting Services Reports
We recommend two techniques for configuring SSRS reports for use in a multi company environment.

1. Publish a Copy Of Each Report For Each Company
Using the Report Manager Web application, a report can be published to multiple folder locations on
the Report Server, with each copy configured to use a different company specific data source.

2. Configure Each Report to Dynamically Select a Company at Run Time
Using the report designer application, the data source definition of the report can be modified to use
the value of a report parameter, in order to specify the company database in which to execute the
report query.

This will require changing the report from using a shared data source to using an embedded data source.
The connection string of the embedded data source can be defined as an expression that dynamically
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sets the company database from a report parameter value. Below is a screenshot of the Data source
window using a dynamic connection string.

Use the following steps to configure a particular report to use a report parameter value for company
selection:
1. Open the report in a Report Server project in Business Intelligence Development Studio or
Visual Studio.
2. Select the Data tab of the report in the design surface.
3. Open the Dataset window for the GPCompany dataset, by clicking on the ellipsis button
next to the Dataset drop down list in the Data tab.
4. Open the Data Source window for the dataset, by clicking on the Data Source ellipsis button
in the Query tab of the Dataset window.
5. Uncheck the Use shared data source reference check box.
6. Set the data source type to Microsoft SQL Server.
7. Enter an expression for the connection string, setting the Initial Catalog to be the value of
the report parameter that specifies the current company database in Dynamics GP:
8. ="Data Source=localhost;Initial Catalog=" & Parameters!CompanyID.Value
9. Specify the credentials for the data source.
10. Save and publish the report to the Report Server.
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Report Requirements and Considerations
The reports you choose to use when printing with Forms Printer can be simple modifications to the
Crystal or SRS report templates shipped with Forms Printer or they can be created from scratch in your
tool of choice.
In either case it is important to note that ALL Forms Printer reports have certain requirements and
critical considerations regarding their design and content.

Report Requirements
The requirements for reports to be printed using Forms Printer are all based upon the report’s
parameters. Reports used in Forms Printer will error if the following parameter requirements are not
met. The requirements are:
1. The Minimum Parameter Count - Your report may have more than the required parameters
but may not have fewer than those indicated in the templates or errors will occur and the
report will not print.
2. The Parameter Order
3. The Parameter’s Data Type

Important Considerations
Along with Parameter Requirements, each report has important considerations which must be
understood and in MOST cases, heeded so that the report can display as intended. These important
considerations include:
1. Report Tables
2. Report Table Joins
3. Report Selection Criteria
While a report used in Forms Printer will not error without the suggested tables, joins and selection
criteria, there is a VERY likely chance that the report will not display the correct data intended by the
Dynamics GP printing process if any of these considerations are not followed.
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Troubleshooting Guide
Initialization Error
The Add-In Initialization Error occurs when there is a mismatch between the Forms Printer Add In dlls
and the Forms Printer dictionary (.dic) file versions. The most likely cause of this is error is that the
Forms Printer FPD1230.dic and ASI1655.dic files were not removed from the Dynamics GP client
directory after the installation process and prior to launching Dynamics GP.
The error dialog is shown below:

You can correct the error by removing, or renaming the FPD1230.dic and ASI1655.dic files and then
launching Dynamics GP again.

Installation Errors
SQL Installation Errors
If you receive an unsuccessful message when installing on a SQL database, you may be able to
determine what SQL Table or Stored procedure is causing the initialization to fail by using "Dexterity SQL
Logging" on the workstation on which you are trying to initialize. This is done by editing the [General]
section of the DEX.INI file to include the following lines:




SQLLogPath=c:\
SQLLogSQLStmt=TRUE
SQLLogODBCMessages=TRUE

Then log into Microsoft Dynamics™ GP and attempt to Initialize Forms Printer- a log file named
c:\dexsql.log will be created, and if you open it with notepad at the point of the error, you will see the
SQL statement that caused the error: You may be able to delete the ASI123* table (if it contains no
data) and its associated zDP_ASI123* stored procedures and then try again and see if you get past the
issue.
If you can send that dexsql.log to us, we may be able to determine what is happening.
NOTE: After logging out of Microsoft Dynamics™ GP, be sure to remove the lines above from DEX.INI or
set them to FALSE so as to not affect performance of your system or fill up your disk with the log file.
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Registration Errors
When entering Registration keys, a failure to register warning typically occurs for 3 main reasons:
Cause

Resolution

Mistyped Registration Keys

Double check the keys entered and use cut and paste if possible.

Incorrect Site name

Double check the site name on the Registration Keys document
provided by Accountable Software. If there is a discrepancy from your
actual Site name, contact us to receive a new set of keys.

Incorrect User Count

Double check the number of licensed users enabled by the keys issued
and compare to your number of System Manager users. If the keys
enable fewer users you will need to contact Accountable for new keys.

Report Parameter Errors
The error ASI_SetParameters shown below occurs when the report being printed has fewer parameters
than is expected by Forms Printer.

This error is followed by the dialog below which displays the ParamNumber, and the ParamValue.

ParamNumber indicates which Parameter on the report has the issue. ParamValue indicates the value
that was passed to that report parameter.
To correct report parameter issues, compare the parameters of the report being printed to the
matching template report shipped with Forms Printer.
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Email Setup Errors
In order to function properly, Forms Printer must find an Address list for possible mail source addresses.
By default, it attempts to use Outlook and an Address List named “Global Address List”, which exists by
default in Microsoft Exchange environments. If Outlook or this address list is not found, errors will occur
during Forms Printer Setup.
The symptom, possible cause and resolution are listed below:
Symptom

Cause
Outlook is not
installed or in use
on the Client
machine.

Resolution
If you are not using Outlook as your Mail Client, you may set
the ASIFPUseOutlook Dex.ini setting to FALSE. This will
disable the Outlook option completely, and Forms Printer
will not try to connect to Outlook in any way.

The cause of the dialog is that Forms Printer is unable to
retrieve the Required Address List while communicating with
Outlook.
Error “Can’t get address list
object with this name from
Redemption object” or similar.
Some functionality of Mail
delivery is restricted similar to
the restrictions for Crystal
MAPI.

The client machine
failed to retrieve
the Exchange
Server Global
Address List

You can change which Address List Forms Printer attempts
to use by changing the ASIFPOutlookFolder setting in the
Dex.ini file. The list name entered in the Dex.ini must be a
valid Outlook Address List. For Example, you could change
the list to the Outlook ‘Contacts’ list by changing the Dex.ini
setting to: ASIFPOutlookFolder = Contacts where by default
it is ASIFPOutlookFolder = Global Address List.
If your environment is such that you cannot create a
Contacts or other common address list that would be
available on each workstation, you can set the Address List
to use to be “ASIFPOutlookFolder=NONE which will
preserve most functionality, but only allow sending from
“Default Outlook User”.
This option is useful when using Outlook Offline while
testing or demoing Forms Printer.
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Invalid TLV Record Error
When using Crystal Reports as the reporting engine, the “Invalid TLV Record” error is displayed for two
known reasons:
Cause

The Crystal Report rpt file was saved
using a Crystal Reports application
version that is not compatible with
the version of Crystal Reports dlls
registered on the workstation.

Resolution
Re-run the Forms Printer install on the workstation, ensuring the correct Forms
Printer and version of Crystal Reports is used.
Or
Open and save the report in a version of Crystal compatible with the version
installed on the workstation.
NOTE:
Advanced users may wish to use the Registry Editor to check the registered
version of the Crystal dlls. That version can be found in the key:
HKEY_CLASSES_ROOT\CrystalRuntime.Application\CurVer
Replace the dlls in the Dynamics GP folder with the version that matches the
currently registered Crystal dlls.

The Crystal Reports dlls registered on
the workstation do not match those
installed to the Dynamics GP folder
and being used by Forms Printer.
Note that this occurs when an
installation discrepancy between
Crystal Reports XI and Crystal
Reports XI “R2” (release 2) exists.

To replace these files first requires that the version registered is identified. To
do this, advanced users can use the Registry and follow these steps:
1. Find the key:
HKEY_CLASSES_ROOT\CrystalRuntime.Application.11\CLSID
2. Copy the listed GUID
3. Search for that GUID under the key:
HKEY_CLASSES_ROOT\CLSID
4. When found, expand to see the folder InprocServer32
5. Click on the folder to see the results on the fight hand pane
6. Check the Data column value. Here will be displayed a path to
the registered Crystal dlls.
If the path is:
<drive>:\Program Files\Common Files\Business
Objects\3.0\bin\craxdrt.dll
Then the registered version is Crystal XI “r1”
If the path is:
<drive>: Program Files\Business
Objects\Common\3.5\bin\craxdrt.dll
Then the registered version is Crystal XI “r2”
The resolution to this issue is to replace all dll files in the Dynamics GP client
folder that begin “CRPE” with the correct version identified by the above
procedure. The correct version of these files can be found at the paths listed
above in blue. B sure to copy the matching version identified in the registry.

Blank Statement
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Frequently Asked Questions
Question: What version of Crystal Reports does Forms Printer install and support?
Answer:

As of version 10.50, Forms Printer installs version XI (11) r2 of Crystal Reports. That
installation means that Forms Printer is compatible with versions 9, 10 and 11 (r1 and r2) of
Crystal reports. So, any reports designed in any of those versions can be run with Forms
Printer version 10.50.

Question: If we purchase Forms Printer do we also have to purchase Crystal Reports?
Answer:

Forms Printer installs all of the files required to run a Crystal Report on a client workstation
that is running Dynamics GP. In order to modify or create Crystal Reports you would
typically purchase at least one copy of Crystal Reports and install it on the report designer’s
workstation. No other Dynamics GP users would need a Crystal License.
Note: Crystal Reports licensing varies in the Terminal Server / Citrix environment. Please
contact Business Objects for details on licensing compliance if using either of those
environments.

Question: Do we have to purchase Adobe Acrobat Writer to print to PDF with Forms Printer?
Answer:

No. Forms Printer installs the Crystal runtime components and SQL Reporting Services files
needed to export to PDF. No additional license or product is needed.

Question: I don’t see the report I want to print when I go Into Forms Printer Setup, why not?
Answer:

Forms Printer prints a very specific list of reports. If the report is not listed in the Forms
Printer setup window, it cannot be printed by Forms Printer. If this report is critical to your
needs, please contact Accountable Software and we can discuss the possibility of adding it.

Question: How do I know if I need new Registration Keys for Forms Printer?
Answer:

New registration keys are required whenever you are installing a newer major version
release of Dynamics GP, whenever you are increasing your number of System Manager user
licenses, and when your Registered Dynamics GP Site name is changed.

Question: What version of SQL Server does Forms Printer support?
Answer:

When using the Crystal Reports Engine, SQL Server 2000 and higher are compatible with
Forms Printer.
In order to use SQL Reporting Services as the Reporting Engine you must be using SQL
2005 or higher.

Question: Can I email using a Mail Client other than Outlook?
Answer:

Forms Printer includes specific functionality to support Outlook and can only use Outlook
when using the SQL Server Reporting Services Engine.
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When using the Crystal Reports Engine and Crystal MAPI, any E Mail client supported by
Crystal Reports can be used. Consult Business Objects’ documentation for Email clients
supported by Crystal Reports.
Question: Why are there tables with names that begin with “ASI” in the report templates?
Answer:

In order to mimic the functionality of the Dynamics GP printing processes, Forms Printer
must often create SQL Tables to store data that is generated during the Dynamics GP print
process. When a template contains an “ASI” named table, it is typically required in order to
properly print the report.

Question: Can bar codes be used on Crystal Reports?
Answer:

Yes. In order to use a bar code, you need to have a barcode font installed on all workstations
that will print using Forms Printer, and you must modify your report to use that bar code
font for the field(s) to be bar coded. Typically, you would use a calculated field that
displayed the correct start and stop characters for the desired bar code type.

Question: Which Forms Printer Report Setup name maps to which Check Format?
Answer:

From the Print Payroll Checks window, you will see displayed the list of Check Formats.
Below is a list of these formats with their corresponding Forms Printer Setup name:
Check Format
Stub on Top - Continuous
Stub on Bottom - Continuous
Stub on Top and Bottom – Single Feed
Other - Continuous
Other - Single Feed

Forms Printer Setup Name
Employee Checks Stub on Top-D
Employee Checks Stub on Bottom-D
Employee Checks Stub on Bottom-L
Employee Checks Other -D
Employee Checks Other -L

Question: Which Forms Printer Report template maps to which Project Accounting Report?
Answer:

A list at the end of this document includes all of the Forms Printer Template file names and
their corresponding Project Accounting Report.

Question: Can Crystal Reports print a MICR bar code?
Answer:

Yes. In order to use the MICR Font for check printing, you must purchase and install a
version of the MICR font then set the MICR field on the Crystal Report to use this Font Type.
When printing MICR Checks, it is also necessary to have a MICR toner cartridge installed in
the printer. You may also want to purchase special Non-duplicatable paper for your check
stock.
Sources for MICR and barcode fonts:
http://www.bizfonts.com
http://www.micrfonts.com
http://www.adobe.com/type/main.html
These sources are provided for information only. Accountable Software does not endorse or
support specific products from these companies.
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Contacting Technical Support
Accountable Software Technical Support is available Monday through Friday from 9:00 am to 5:00 pm
EST. Technical Support can be reached in the following ways:
484.875.0600 (voice)
484.875.0620 (fax)
TechSupport@accountable.com
http://www.accountable.com

When you call, fax, or Email Accountable Software for support, please include the following information:
•
•
•
•

Your name
Your company name and phone number
The name of the product you are working with and the version you are running (from the
registration window)
A brief description of the problem.

In addition, have this manual available when you are connected with Customer Support. You may be
directed to various pages in the manual as you receive assistance.
Please also be aware that all technical support issues are chargeable unless the issue you are calling
about is a result of a defect in an Accountable Software product or accompanying documentation.
Customers without pre-paid support incidents, will be required to provide credit card information prior
to opening an incident, but will not be charged if the call is non-billable.
For the latest Accountable Software Support Policies, see the “Support” section of the Accountable
Software Web site at www.accountable.com.
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Project Accounting Report Mapping
Below is the list of Sample reports and the Project Accounting report these samples are designed to support. It is important during Forms Printer
setup, that the correct sample report be used when creating these mappings. These reports are not interchangeable, you must use the correct
report or you will receive no data, incorrect data or an error.
Billing Format Name
T&M Summary A
T&M Summary B
T&M Summary C
T&M Detailed A
T&M Detailed B
T&M Detailed C
T&M Consulting Project
T&M Consulting Project With Tax Detail
T&M Consulting Contract
T&M Consulting Contract With Tax Detail
T&M Detailed Project
T&M Detailed Project With Tax Detail
T&M Detailed Contract
T&M Detailed Contract with Tax Detail
T&M Pre-Billing Worksheet
T&M Basic
T&M Invoice 1
T&M Invoice 2
T&M Invoice 3
T&M Invoice 4
CP/FP Document Level Invoice
CP/FP Contract Level Invoice
PA
Invoice
Format
CP/FP Contract Level
CP/FP
Project
Level Invoice
Invoice
CP/FP Contract/Project Level Invoice

Forms Printer Setup / Report Writer Name
PA Billing Summary A Report Format
PA Billing Summary B Report Format
PA Billing Summary C Report Format
PA Billing Detailed A Report Format
PA Billing Detailed B Report Format
PA Billing Detailed C Report Format
PA Billing Invoice Format - Invoice Format 1
PA Billing Invoice Format - Invoice Format 2
PA Billing Invoice Format - Invoice Format 3
PA Billing Invoice Format - Invoice Format 4
PA Billing Invoice Format - Invoice Format 5
PA Billing Invoice Format - Invoice Format 6
PA Billing Invoice Format - Invoice Format 7
PA Billing Invoice Format - Invoice Format 8
PA Billing Invoice Format - Invoice Format 9
PA Billing Invoice Format - Invoice Format 10
PA Billing Invoice Format - Invoice Format 11
PA Billing Invoice Format - Invoice Format 12
PA Billing Invoice Format - Invoice Format 13
PA Billing Invoice Format - Invoice Format 14
PA Invoice Format CP/FP Document Level Invoice
PA Invoice Format CP/FP Contract Level Invoice
PA Invoice Format CP/FP Project Level Invoice

Forms Printer Template Report Name
PA Billing Summary A.rpt
PA Billing Summary B.rpt
PA Billing Summary C.rpt
PA Billing Detailed A.rpt
PA Billing Detailed B.rpt
PA Billing Detailed C.rpt
PA Billing Invoice Format 1,2,5,6.rpt
PA Billing Invoice Format 1,2,5,6.rpt
PA Billing Invoice Format 3,4,7,8.rpt
PA Billing Invoice Format 3,4,7,8.rpt
PA Billing Invoice Format 1,2,5,6.rpt
PA Billing Invoice Format 1,2,5,6.rpt
PA Billing Invoice Format 3,4,7,8.rpt
PA Billing Invoice Format 3,4,7,8.rpt
PA Billing Invoice Format 9-14.rpt
PA Billing Invoice Format 9-14.rpt
PA Billing Invoice Format 9-14.rpt
PA Billing Invoice Format 9-14.rpt
PA Billing Invoice Format 9-14.rpt
PA Billing Invoice Format 9-14.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
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Billing Format Name
CP/FP Pre-Billing Worksheet
CP/FP Basic
CP/FP Invoice 1
CP/FP Invoice 2
Fee Document Level Invoice
Fee Contract Level Invoice
Fee Project Level Invoice
Fee Contract/Project Level Invoice
Detail Page - Document Level Invoice
Detail Page - Contract Level Invoice
Detail Page - Project Level Invoice
Detail Page - Contract/Project Invoice
Summary Page - Document Level Invoice 1
Summary Page - Document Level Invoice 2
Summary Page - Document Level Invoice 3
Summary Page - Document Level Invoice 4
Summary Page - Document Level Invoice 5
Summary Page - Contract Level Invoice 1
Summary Page - Contract Level Invoice 2
Summary Page - Contract Level Invoice 3
Summary Page - Contract Level Invoice 4
Summary Page - Contract Level Invoice 5
Summary Page - Project Level Invoice 1
Summary Page - Project Level Invoice 2
Summary Page - Project Level Invoice 3
Summary Page - Project Level Invoice 4
Summary Page - Project Level Invoice 5
IV Document Level Invoice
IV Contract Level Invoice
IV Project Level Invoice
IV Contract/Project Level Invoice
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Forms Printer Setup / Report Writer Name
PA Invoice Format CP/FP Pre Billing Worksheet
PA Invoice Format CP/FP Basic
PA Invoice Format CP/FP Invoice 1
PA Invoice Format CP/FP Invoice 2
PA Invoice Format Fee Document Level Invoice
PA Invoice Format Fee Contract Level Invoice
PA Invoice Format Fee Project Level Invoice
PA Invoice Format Fee Contract/Project Level Invoice
PA Invoice Format Document Detail Page 1
PA Invoice Format Contract Detail Page 1
PA Invoice Format Project Detail Page 1
PA Invoice Format Contract/Project Detail Page 1
PA Invoice Format Document Summary Page 1
PA Invoice Format Document Summary Page 2
PA Invoice Format Document Summary Page 3
PA Invoice Format Document Summary Page 4
PA Invoice Format Document Summary Page 5
PA Invoice Format Contract Summary Page 1
PA Invoice Format Contract Summary Page 2
PA Invoice Format Contract Summary Page 3
PA Invoice Format Contract Summary Page 4
PA Invoice Format Contract Summary Page 5
PA Invoice Format Project Summary Page 1
PA Invoice Format Project Summary Page 2
PA Invoice Format Project Summary Page 3
PA Invoice Format Project Summary Page 4
PA Invoice Format Project Summary Page 5
PA Invoice Format IV Document Level Invoice
PA Invoice Format IV Contract Level Invoice
PA Invoice Format IV Project Level Invoice
PA Invoice Format IV Contract/Project Level Invoice

Forms Printer Template Report Name
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt CP-FP.rpt
PA Invoice Frmt Fee Document Level.rpt
PA Invoice Frmt Fee Contract Level.rpt
PA Invoice Frmt Fee Project Level.rpt
PA Invoice Frmt Fee Contract - Project Level.rpt
PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt
PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt
PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt
PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Invoice Frmt Doc, Con, Proj Sum Pg1-5.rpt
PA Inv Frmt IV Document Level.rpt
PA Inv Frmt IV Contract Level.rpt
PA Inv Frmt IV Project Level.rpt
PA Inv Frmt IV Cont-Proj Level.rpt

Billing Format Name
GST PA Billing Blank Invoice Form
GST PA Billing Blank Return Form
GST PA Billing Blank History Invoice Form
GST PA Billing Blank History Return Form
PO Format A (Project Accounting Only)
PO Format B (Project Accounting Only)
PO Format C (Project Accounting Only))
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Forms Printer Setup / Report Writer Name
GST PA Billing Blank Invoice Form
GST PA Billing Blank Return Form
GST PA Billing Blank History Invoice Form
GST PA Billing Blank History Return Form
PO Format A
PO Format B
PO Format C

Forms Printer Template Report Name
PA Billing GST Invoice.rpt
PA Billing GST Invoice.rpt
PA Billing GST Invoice.rpt
PA Billing GST Invoice.rpt
PA PO Format 1-3.rpt
PA PO Format 1-3.rpt
PA PO Format 1-3.rpt

